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File Menu

The File menu includes commands that enable you to open and save files, and to print.

For more information, select the File menu command name

New
Open
Open Picture
Import Text
Close
Save
SaveAs
Export Text
Print
Print Setup
Recent file list
Exit



Edit Menu

For an Outline
The outline Edit menu includes commands that enable you to copy an outline to the 
clipboard, move and insert lines, select a portion of an outline, center an outline and redraw 
an outline to VisualOutliner style.

For more information, select the outline Edit menu command name

Copy picture Copy as picture to clipboard
Move Move line and children
Insert Insert a line
Select Select rectangular region of outline
Center Outline Move the whole outline to the center
Redraw Redraw outline to VisualOutliner style

For a Note
The note Edit menu includes commands that enable you to move text to and from the 
clipboard, to delete text, and to undo a previous editing operation.

For more information, select the note Edit menu command name

Undo Cancels a previous operation
Cut Deletes text and moves it to the clipboard
Copy Copies text to the clipboard
Paste Moves text from the clipboard to the note
Delete Delete highlighted text
Select All Select all the text in the note
Wordwrap Resizes note text to fit note window



Search Menu

The Search menu allows you to find and replace text sequences within the currently active 
note.

For more information, select the Search menu command name

Find
Find Next
Replace



View Menu

The View menu allows you to swap between viewing a note and picture or its associated 
outline.
For more information, select the View menu command name

Outline
Note
Picture



Format Menu

The Format    menu includes commands that enable you to alter the default text Alignment, 
Font attributes, Line color and outline Background color.

For more information, select the Format menu command name

Alignment
Font
Line
Background



Options Menu

The Options menu includes commands that enable you to automatically center an outline 
within it's document window, view the outline as it is redrawn, toggle the 3D effect, show/ 
remove the status bar, set autosave settings, and set confirmation defaults.

For more information, select the Options menu command name

Auto Center
Visible Redraw
3D Effect
Show Status
Autosave
Confirmation



Window Menu

The Window menu includes commands that enable you to manipulate the note and outline 
documents within the workspace. Commands allow you to Tile or Cascade windows, Arrange 
icons, and Close all windows.

For more information, select the Window menu command name

Tile
Cascade
Arrange Icons
Close All



Help Menu

The Help menu includes commands that enable you to access the VisualOutliner on-line Help
contents page, Search for help on a specific topic, and get Help on using the on-line help 
system.

For more information, select the Help menu command name

Contents
Search for Help On
How to Use Help
About VisualOutliner



Toolbar

The Toolbar contains tools which you can use to manipulate the active Outline window.

Start a new outline

Open an existing outline

Save current outline, specifying filename

Print current outline, and/or all of it's notes

Assign Bold style to currently selected outline text

Assign Italic style to currently selected outline text

Assign Strikethrough style to currently selected outline text

Align outline text to the left of it's line/ outline title box on currently selected outline 
text

Align outline text to the center of it's line/ outline title box on currently selected 
outline 

Align outline text to the right of it's line/ box on currently selected outline 

Select a rectangular area of an outline, useful for editing large areas of the outline at 
once.

Move a line and all it's children to another part of the outline.

Insert line between two other lines.

Assign a line width of 1 point to the currently selected outline lines.

Assign a line width of 2 points to the currently selected outline lines.

Assign a line width of 3 points to the currently selected outline lines.

Assign a line width of 4 points to the currently selected outline lines.
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ASCII

American Standard Code for Information Interchange. Most applications can import text that
is in the ASCII format.which VisualOutlinercan export.



Child

A line or outline title box can have other lines emanating from it. These other lines describe 
the line in more detail, and are called the children of the line or title box.



Head

The end of a line which touches it's parent.



Keyword

A Keyword refers to the text on a line or in the title box. It is good practice to keep to a single
word per line.



Line

A line has one concept or keyword associated with it, preferably expressed as one word 
which sums up what you are describing. Lines can be of any length and can have up to 25 
characters.



Menu bar

The menu bar contains the commands available for the active document window. There are 
four menu's in VisualOutliner. One for outlines, one for notes, one for pictures, and one for 
when no document windows are open. See the individual command you are interested in for 
more information.



Node

Either end of a line. Can also refer to the outline title box



Note

Each line or keyword in an outline can have a note associated with it. You can have as many 
notes open as you wish, however all notes cannot contain more than 32,000 characters total
(around 10 pages). notes do not have to be saved separately - they are saved automatically 
when you save an outline.



Outline

An outline consists of a main title in a box, with the main theme lines emanating from the 
box, and more detailed keywords emanating from the theme lines, each line can have one 
note attached. You can edit more then one outline at the same time, this allows you to work 
on two or more related outlines concurrently.



Outline text edit box

The outline text edit box is where you type in the text which will appear on a line or in the 
outline title box. If the text you are typing is too large for the edit box, the text will be 
scrolled to the left.



Outline title box

The outline title box contains the main title for the outline, this need not be the same as the 
outline's filename. The title should sum up the meaning of the entire outline.



Parent

A parent refers to the line from which a child line is emanating. A line can have only one 
parent, and that parent may be the outline title box. The children of a parent describe the 
parent in more detail.



Status bar

The status bar is displayed at the bottom of the workspace and can be hidden if more space 
is needed. It shows menu help text, file open/save progress indicators, and editing status 
information.



Theme

The lines emanating from the outline's title box are called the main themes of the outline.



Tail

The tail is the end of a line furthest away from it's parent line. The tail of a line may have 
child lines attached to it.



Title bar

The VisualOutliner application, outline document windows, and note document windows, all 
have title bars. They usually name the window in question, often displaying the filename of 
the information contained in the window.

The exception to this is the note window, which displays the associated line text as it's title.



Toolbar

The Toolbar contains tools which allow you to manipulate the current outline.



Workspace

The Workspace is the main VisualOutliner window area where outlines and notes can be 
viewed.



File New Command

Create a new outline, automatically name the outline Outline N, where N is an unique 
number identifying the Outline. N will increase by 1 for each new outline created.

The 'New Outline' tool on the toolbar can also be used to create a new outline.



File Open Command

Open an existing outline.

The default format for an outline (listed in the 'list files by type' combo box of the File Open 
dialog), is 'normal' (.MAP) format. .MAP is VisualOutliner's native file format - this format 
stores all the text, color & line position details of an outline.

If you have created a textual(ASCII format) outline using a text editor such as Windows 
Notepad, the VisualOutliner can convert this automatically to normal (native) format. 
VisualOutliner applies default values for line color, text sizes etc. because this information is 
not held in the text outline. The outline will automatically be drawn to the standard 
VisualOutliner style.

VisualOutliner expects a textual outline to have a .TXT file extension. A text outline might 
look like this:-

Outline Title
[tab]Theme1
[tab]Theme2
[tab][tab]Keyword2.1
[tab][tab]Keyword2.2
[tab]Theme3

Note: that an outline's 'levels' are denoted by tab characters in the text file. The levels must 
be denoted by tab characters and not spaces.

Important: Notes cannot be opened/ saved as part of an outline when using text    file 
format. Notes should be imported separately via the note File menu's Import Text option.

The 'Open Outline' tool on the toolbar can also be used to open an outline.



File Open Picture Command
Associate a bitmap file with a line. This option is only available when a picture window is 
active.

You should have prepared a bitmap file previously by using another application such as 
Windows Paintbrush, or Microsoft Excel. VisualOutliner cannot create or edit a bitmap, you 
should use the original application to do this.

NB: The bitmap name and location are saved as part of the outline, and not the bitmap file 
itself, so you should not delete the bitmap file if you want to see it as part of an Outline.



File Import Text Command

Import text file into note. This option is only available when a note is active.

The note's current contents, if any, will be overwritten by the imported text. The imported 
file can be up to 32,000 characters in length but must not exceed this.

The file must be in standard ASCII text format such as that produced by the Windows 
Notepad accessory.

NB: You can create a textual outline in a note, which could then be exported & subsequently 
opened and edited in an outline window.



File Close Command

Close the active document window.

If an outline is active, then close the outline and any associated notes. If you have made 
changes to the outline since last saving, then you will be prompted to save the outline 
before it is closed.

If a note is active, then close the note. This does not delete the note from the outline, it 
simply closes the note's window. You could view the note again by selecting the View note 
menu option, or double-clicking the left mouse button on the specific line.

If a picture is active, then close the picture This does not delete the picture from the outline, 
it simply closes the picture's window. You could view the picture again by selecting the View 
picture menu option

NB: Notes are automatically saved when you save an outline - they do not need to be saved 
separately. Similarly with pictures, the name and location of the bitmaps are saved when you
save an outline.



File Save Command

Save outline without being requested to supply a file name. VisualOutliner will save the 
outline using the name in the outline document windows' title bar.

You would usually save an outline in normal .MAP format. If you want to transfer the textual 
information in an outline to a wordprocessor or text editor, then you can save it in ASCII text 
(.TXT) format. TXT format is explained in the File Open Command topic.



File Save As Command

Save outline and supply a file name. File names can be up to 8 characters in length.

You would usually save an outline in normal .MAP format. If you want to transfer the textual 
information in an outline & notes to a wordprocessor or text editor, then you can save it in 
ASCII text (.TXT) format. TXT format is explained in the File Open Command topic.

The 'Save Outline As' tool on the toolbar can also be used to save an outline.



File Export Text Command

Export note text to ASCII text file. This option is only available when a note is active.

This is useful if you want to use the VisualOutliner note text in another application. For 
example, the note may be the basis of a marketing flyer which you finalize by importing the 
text into a Desktop Publishing (DTP) package.

Note: This option is grayed if the note is empty.



File Print Command

Print to current default printer. (The default printer can be changed in the Windows Control 
Panel).

For an Outline
The following print options are available:-
Outline Print currently active outlineNotes Print all of the currently active outline's 

notes
Pictures Print all of the currently active outline's pictures.

For a Note
Prints currently active note.

For a Picture
Prints currently active picture.



File Printer Setup Command

Specify print set-up options.

These include settings that will depend on the type of printer you are using.

Note: If the option is available, it is important to use a symmetric aspect ratio for a printer's 
graphics resolution. For example, if a printer has graphic resolution options of 360 by360 
and 360 by 180 dots, then choose the 360 by 360 resolution. This will stop text from 
appearing slanted on the printed page.



File Recent file list

A list of recently used files (up to 4 in total).

Used for quickly opening outlines that have recently been edited.



File Exit Command

Close down the VisualOutliner application.

If you have made changes to any outlines since last saving them, then you will be prompted 
to save each individual outline before it is closed.

Note: Notes are automatically saved when you save an outline - they do not need to be 
saved separately.



Edit Copy Picture Command

Copy outline as a picture to the clipboard.

The visible area of the outline (as viewed in it's document window) is copied to the 
clipboard.
Note: VisualOutliner does not copy the entire outline to the clipboard - only the part visible in
it's document window.

When copying an outline picture for subsequent pasting into applications such as Word for 
Windows, make sure you choose your outline color scheme so as to complement the host 
document.



Edit Move Command

Move line (and it's children if any present)

After selecting Edit Move from the menu, or selecting the Move tool from the Toolbar, click 
the left mouse button on the tail of the line you want to move. Drag the mouse until the 
dragged line's head is near to the line you want to attach it. Release the left mouse button 
and use the mouse to rotate the moved line to the required position around it's new parent.



Edit Insert Command

Insert a line between two other lines.

After selecting Edit Insert from the menu, or selecting the Insert tool from the Toolbar, click 
the left mouse button on the junction of the two lines you want to insert a line between. 
Drag the mouse to make an appropriately sized line. Release the left mouse button - the new
inserted line has been created.



Edit Select Command

Select a rectangular area of the outline.

After selecting Edit Select from the menu, or selecting the Block select tool from the Toolbar, 
click the left mouse button and drag the mouse. You will see a dotted rectangle which 
selects the area over which you have dragged the mouse. Release the left mouse button, 
the selected area will be displayed in reverse.

You may now perform many operations which will act on the parts of the outline which are 
touched by the selection rectangle. For example, you may change the text style to italic , by 
clicking on the Italic tool in the Toolbar, or you may change all lines to green by selecting 
Format Line from the menu and selecting green for line color. Note: the previous command 
would also change the default line color for subsequent editing.

To remove the highlighted selection:
Start editing the outline - eg. draw a new line, or
Double-click on the selection tool in the toolbar.



Edit Center Outline Command

Move the whole outline to the center so that the outline title box is in the center of the 
outline's document window.



Edit Redraw Command

Redraws outline to a specific style. Save your outline before using this option - you may not 
like the style of outline drawn by VisualOutliner.

If you do not want the overall shape of your outline to change, then you should not use this 
option.



Edit Undo Command

Cancels a previous operation in the note. Use if you want to undo a typing error.

Note: This option is grayed out if there is nothing to undo.



Edit Cut Command

Deletes the selected text from the note and moves it to the clipboard.

This option is grayed out if there is no text selected in the note.



Edit Copy Command

Copies the selected text from the note and puts it in the clipboard.

This option is grayed out if there is no text selected in the note.



Edit Paste Command

Copies text from the clipboard (if present) into the note at the current editing position.

This option is grayed out if there is no text in the clipboard.



Edit Delete Command

Delete the note's highlighted text.

This option is grayed out if there is no text selected in the note.



Edit Select All Command

Select (Highlight) all the text in the note.



Edit Wordwrap Command

Resizes note text to fit note window.

Words will automatically be wrapped around to the next line if they cross over the right 
margin of the note.



Search Find Command

Displays a dialog prompting for the string to find.



Search Find Next Command

Use the F3 function key or menu command to search for the next occurrence of the string 
you last searched for using the Search Find command.



Search Replace Command

Displays a dialog prompting for the original and replacement strings.



View Outline Command

Displays the outline which belongs to the currently active note or picture.

NB: This command is only available when a note or picture is active.



View Note Command

Displays the note which belongs to the currently selected line or picture. Double-clicking the 
left mouse button on any line has the same effect of opening the note for that line.

NB: This command is only available when an outline or picture is active.



View Picture Command

Displays the picture which belongs to the currently selected line or note. If no picture is 
currently associated then use the File Open Picture command to display it.

NB: This command is only available when an outline or note is active.



Format Alignment Command

Select the default alignment for text on a line, or outline title box

Left Aligns text to the left of a line
Right Aligns text to the right of a line
Center Aligns text to the center of the line



Format Font Command

Changes the font, style, size, and color of the text in selected block, or current line/ outline 
title box if no block is selected.

Font

Lists available scalable fonts. 
You can select a font or type the name of the font you want in the box above the list of fonts.

Font Style

Lists the available font styles.    You can select one of the styles in the list.

Size

Lists the available sizes for the font selected in Font box. 
You can select a font size or type the size you want in the box above the list of sizes.
Lines can have text sizes between 8 and 50 points, the outline title box can have text sizes 
between 8 and 19 point.

Effects

Strikeout

Formats selected text with a line through the middle. This can be used to signify work
already completed in the outline.

Color

Controls the text color.    Select a color from the list.

Sample

Shows a sample of text with the current font formatting choices applied.



Format Line Command

Choose between 16 line colors and 4 line widths.

Note: If the outline title box is currently selected, then changing the line color will change 
the box color 

Use thicker lines at the center of the outline, and thinner lines at the periphery. This will 
draw attention to the main themes of the outline.

One color scheme would be to individually color each theme (together with it's children).The 
use of color makes the outline more interesting, and can make it easier to read.



Format Background Command

Choose between 16 background colors.

It is recommended that you choose a dark color for the background, so that the outline 
stands out clearly and is easy on the eye.



Options Auto Center Command

Automatically centers an outline within it's document window, when window is resized.

This is useful if you find yourself resizing document windows frequently, and need the 
outline title box to stay at the centre of a document window.



Options Visible Redraw Command

View the outline while it's being redrawn, recommended for slow PC's.

On slow PC's, you will notice a significant delay when displaying a large or complex outline. 
To see the progress of screen painting as it takes place, turn Visible Redraw on.

On fast PC's, however, it is more visually pleasing to turn Visual redraw off.



Options 3D Effect Command

Toggles the sunken 3D effect for status message box and outline text edit box.

This option is best turned off for certain LCD screens, where white lines are not very visible.



Options Show Status Command

Remove/ restore the status bar.

Remove the status bar if you need the maximum available screen space for your outline or 
note.

The status bar displays:

Menu help describing each menu command as you select each item on a menu.
Percentage of a file that has currently been Opened/ Saved.
Help on the current outline editing mode.



Options Autosave Command

Use the Autosave facility if you want VisualOutliner to remind you to save your work at 
regular intervals. Autosave asks whether you want to save - you can still cancel the save if 
you wish.

Displays a dialog where you may set the default time for Autosave, the options are:

Low Prompts to save your work every 40 minutes
Medium Prompts to save your work every 20 minutes
High Prompts to save your work every 10 minutes

Never Turns off the Autosave facility (default).



Options Confirmation Command

Displays a dialog which shows any user-definable confirmation options. All confirmations are 
turned on by default.

Confirm file delete
Turn this off if you do not wish VisualOutliner to ask for your confirmation when overwriting 
an outline file.



Window Tile Command

This will fill the workspace with each non-iconized note and outline window such that they do
not overlap, leaving room for any iconized documents at the bottom of the workspace.

Windows are tiled horizontally from left to right.



Window Cascade Command

Displays each non iconized window, starting at the top-left of the workspace.
Overlaps each window in turn, slightly below and to the right of the previous window.



Window Arrange Icons Command

Arrange icons from left to right starting at the bottom-left corner of the workspace.



Window Close All Command

Close all note and outline documents in the workspace.



Help Contents Command

Access VisualOutliner on-line help contents screen.



Help Search for Help On Command

Search for help on a specific topic.

Enter a keyword into the Search dialog, and all relevant topics will be displayed.



Help How to Use Help Command

Explains how to use the help system itself.



Help About VisualOutliner

VisualOutliner About box.

Displays the version number of VisualOutliner you are using, how much memory is available,
and whether a math co-processor is installed.



Change Outline formatting defaults
The outline Format menu option allows you to change the defaults for the current outline, at 
the same time changing the attributes of the current line, outline title box, or currently 
selected outline area.

These defaults will then be used in all new outlines subsequently created during the current 
execution of VisualOutliner.

To change any outline defaults, bring up the required Alignment, Font, Line or Background 
dialog from the outline's Format menu, make any changes you want such as changing text 
alignment, press the OK button and these changes will automatically be reflected in the 
outline.

Note: Using the toolbar to change the text alignment(for example) does not change the 
default text alignment for the outline - any new lines drawn would still be drawn using the 
default text alignment. This applies to all the other tools on the toolbar such as Bold, italic, 
strikethrough and line width.



Drag a line around it's parent
Use the left mouse button to click on the tail of a line (the cursor will change shape to a 
hand), keep the left mouse button down and drag the mouse. The line's tail follows the 
mouse cursor, whilst the line's head remains attached to it's parent.

This allows you to lengthen, shorten and re-position a line about it's parent



Draw a new line
Move the mouse cursor onto the outline window, it will take on the shape of a pen which will 
allow you to draw a line.

Position the mouse cursor a sufficient distance from the tail of another line or the outline's 
title box to accommodate the intended line text, and click the left mouse button. The Line 
will be drawn from the outline title box/ line to the cursor position. You can drag the line 
before releasing the left mouse button, if you wish.

In a large or complicated outline, where there are many lines, the line may not be drawn 
from the line you were expecting, in this case you may need to go close to the outline title 
box/ line in question, and then drag the line out to the required length & position.



Edit Outline title box/ line text
Select the text by moving the mouse cursor over the outline title box or line, and clicking the
left mouse button, the text will be displayed in the outline's text edit box next to the toolbar.
If the text is already selected there is no need to do this.

Type in the line text, or press the F2 edit function key. The focus will automatically be put in 
the edit box. If you want to edit some text at the center of a line then use the cursor keys 
while in the outline text edit box to position the editing caret where you want to insert new 
text, and start typing. The text on the outline will automatically be updated as you type into 
the editing box.



Edit many lines simultaneously
Click on the block select tool in the toolbar or choose the Edit Select menu option.

Move the mouse cursor onto the outline, the cursor will change shape into a crosshair. 
Clicking, dragging, and releasing the left mouse button will result in a rectangular area of the
outline being shown in reverse.

You can now use the tools on the toolbar, or the options in the Format menu to change the 
attributes of all lines that are in the reverse rectangle.

The block select rectangle will then disappear when you perform an operation in the outline, 
for example, drawing a new line, or scrolling the outline.



Import/ Export note text
VisualOutliner allows you to open previously prepared text files into notes, and similarly save
a note's contents to a text file.

If you want to load some text into the current note, make sure the note is empty, as it's 
contents will be overwritten. Select the File Import Text option from the note menu and the 
Import text dialog will be shown. Select the text file you want to load and click on OK. The 
text file will be loaded into the current note.

If you want to save the text in the current note, select the File Export text option from the 
note menu (this option will be grayed & inaccessible if the note is empty). Type in the name 
you want to call the text    file which will contain the note and click on OK. The note will be 
saved to the specified filename.

Note: Notes are saved automatically when an outline is saved - you don't need to save or 
open them separately.



Insert a line between existing lines
Click on the insert line tool on the toolbar or choose the Edit Insert menu option.

Position the mouse cursor over the junction of the two lines. Click, drag and release the left 
mouse button to create the new inserted line.

Note: Lines cannot be inserted between the outline's title box and it's main themes, only 
between two lines.



Move a line to a new parent
Click on the move line tool on the toolbar or choose the Edit Move menu option.

Position the mouse cursor over the tail of the line to be moved. Click on the left mouse 
button and drag the line so that it's head is over the line/ outline title box you wish to move 
it to. Release the left mouse button, and use the mouse to rotate the line around it's new 
parent. When you are satisfied with the new line position, click & release the left mouse 
button one more time. The line will be redrawn at it's new position

Note: Any children attached to the moved line will also be moved.with it automatically.



Open/ Save text format Outlines
To open a text format outline
The text file must be in the ASCII format described in the File Open Command topic. Click on 
the Open new outline tool on the toolbar or choose the File Open option from the outline's 
menu. In the 'List files by type' combo box select '.TXT' format, select the file you want to 
open, and click OK.

To save an outline in text format
Click on the SaveAs tool in the toolbar or choose the File SaveAs option from the outline's 
menu.
In the 'List files by type' combo box select '.TXT' format and click OK. The outline will be 
saved in text format.

Important: Notes cannot be opened/ saved as part of an outline when using text    file 
format. Notes should be imported separately via the note File menu's Import Text option.



Remove unwanted lines
Position the mouse cursor over the tail of the line to be removed. Click on the left mouse 
button and drag the mouse cursor over the head of the line (ie over the tail of it's parent). 
The mouse cursor will change shape into an eraser symbol. Release the left mouse button 
and the line will be erased, together with any note which was attached to it.

Note: Make sure you do not need the information contained in a line's note before deleting a 
line. If you do want the note information, then export the note text before deleting the line 
(see the Import/Export note text topic).



Use VisualOutliner with other Applications
Using a picture of an outline in other applications

Position the outline to your satisfaction within the outline's document window, and select the
required fonts & colors 
Select the Edit Copy Picture option from the outline's menu. The outline will be copied to the 
clipboard as a picture (bitmap).
Most wordprocessors will allow you to paste this picture into their documents. Microsoft Word
for Windows, Windows Write & Paintbrush and Aldus Pagemaker 4.0 are examples of 
applications which will allow you to do this.
The outline picture can then be printed as part of your wordprocessing, drawing or DTP 
document.

Using the text of an outline in other applications

Individual notes can be exported to be used in standard text editors such as Windows 
notepad. They can also be imported into Wordprocessors and DTP software as ASCII text.

An outline (ie. the contents of the title box & lines) can also be saved in text format, which 
can subsequently be used as the base for a report written in your favorite wordprocessor.

Using the Windows Recorder accessory

If you intend to use VisualOutliner during a presentation, you can record an outline (and any 
notes) with the Windows Recorder accessory which is supplied as part of the Windows 
environment and can be run from the 'Accessory' Program Manager group. You can then play
back the recording, leaving you free to discuss the presentation as it is drawn during 
playback.

Before recording, make sure that you select the 'recorded speed' option, so that you can 
then control the speed at which the outline will later be played back.



Product Support
If you have a question about VisualOutliner, try to solve the problem in the following order:-

1. Look in the printed product documentation or on-line Help.

2. Check for any    READ.ME files that    came with your product disk. They may contain 
important information not included in the manual.

3. If VisualOutliner is supported in-house, call your in-house software support team for 
assistance.

4. If you are a subscriber to CompuServe, and have a licensed version, post a question 
to the author's EMAIL postbox on CompuServe (details in printed manual).

The author can be contacted at the following address:-

B. Williams
VisualOutliner Product Support
18 Maley Avenue
West Norwood
London
SE27 9BY



Tutorial
The human brain groups linked thoughts together. When we recall anything,we do not simply
recall a single item, rather we recall thoughts that are associated or linked together. The 
VisualOutliner uses the mind's natural ability to remember and organize, and turns it into a 
powerful reality which can be harnessed for you and your organisations benefit.

The concept behind the VisualOutliner is based on this idea of grouping items associated 
with a common subject. This provides you with an information rich, concentrated store of 
information that is quick and easy to interpret.

The subject theme is at the core of the outline (in the central box), this we term the Outline 
Title Box. Emanating from this Outline Title Box are the keywords that we associate with the 
subject. For example, a To Do List would possibly have a Title of 'To Do List'. Emanating from 
the central box could be several lines, with keywords such as 'shopping', 'gardening', 'DIY', 
etc. Further Keywords could then be associated with each of these Keywords, 'shopping' 
could be subdivided into 'Food' and 'Clothes'.

Each Keyword can have an associated Note and Picture. These can be opened and closed as 
and when required, ensuring the outline remains uncluttered, but with extra information 
available on request.

The VisualOutliner is designed to work the way you want it to - like a pen and paper, but with
all the features you have come to expect from the Microsoft Windows graphical 
environment.

This guide makes frequent reference to using a Mouse, all references apply equally to a Pen 
(this application is pen aware). VisualOutliner cannot work without a pointing device, a 
keyboard is not sufficient on it's own.

Suggested uses
Once you start using VisualOutliner, you will find it enhances mental productivity, improves 
your communications, aids recall, facilitates problem solving and can be used for many day-
to-day business and educational functions.

Figure 1 shows a sample of the uses - you may think of many more. When giving a 
presentation, you may consider using the Windows Recorder accessory to record the Outline 
and play it back during the presentation using a PC linked to an overhead projector. Or you 
may wish to record the key points of a meeting to play back at the end to summarise and 
confirm what has been discussed. The completed Outline could be printed off (with any 
associated notes) and distributed as the minutes of the meeting.

Ask anyone what a spreadsheet can be used for, and they will say - "almost anything". In 
terms of thoughts and ideas, the same goes for VisualOutliner!

Figure 1



Keyboard conventions
This online guide represents keys on the computer keyboard like this: RETURN. Sometimes 
you will need to hold down one key while you press another, eg. hold down ALT and press F4.
This is shown as ALT F4.

To select a menu command, you will need to click on the menu bar popup menu then click 
the required menu item, eg. Click on the File menu popup, a list of commands will appear, 
then click on Open. This is shown as File Open.

Text which you need to type while using VisualOutliner appears as follows:

example text

Using a network
VisualOutliner can be installed on, and run from a network, but cannot be used by more than
one person at the same time.



If you are using VisualOutliner when your computer is connected to a network, you can use 
the network facilities available to you, eg. you can print a document to a printer on the 
network, provided it has been set up correctly within Windows.

Leaving VisualOutliner
Standard Windows procedures apply for exiting    the VisualOutliner. Press ALT F4 or select 
Exit from the File menu. If your work has changed since the last time you saved it, 
VisualOutliner will ask you whether to save the changes before it quits.

The mouse
The mouse cursor changes shape depending on where it is located and what operation is 
being performed. The following table shows the most common shapes you will observe and 
the associated actions. In all instances the left mouse button is used (The right mouse 
button has no function in VisualOutliner).

SYMBOL NAME LOCATION PURPOSE

 Arrow Menu Bar To select a menu command.

Caret Editable Text To edit outline text

Pen On Outline To draw a line.

Hand On    node To drag, move, insert lines

Eraser On    node To erase a line.

Crosshair On outline For selecting a section of the 
outline.

A basic outline
In this section we will produce an outline for the daily schedule of an overworked manager! 
The outline will show at a glance what is to be done, what is completed, and the relevant 
importance of all the tasks. If you follow the steps in this tutorial and complete the example 
outline (this should take no longer than 30 minutes), you will then be in a position to 
produce your own outlines. 

You don't need to complete the whole tutorial in one session, the next section will show you 



how to save your work so that you can return to it at a later time.

When you start VisualOutliner, your first outline will be ready to begin, without having to 
select any options or specify any commands. You will see 'Outline1' in three locations (see 
Figure 3), the Title Bar, the Text Edit field and the Title box.

Figure 3

The Outline Title Box
First of all let's give the outline a title. Type the word Today at the keyboard, the text will 
appear in the title box at the center of the window, replacing the default title, Outline1, in 
the process.

To save the outline, use the left mouse button to click on the Save tool of the Toolbar ( this is
the tool that has a picture of a floppy disk on it). The Save dialog box will appear - type 
today in the filename edit field, and click on OK. The outline will be saved to disk. The 
outline window's title will change to TODAY.MAP, reflecting the outline's new filename.



The first line
When you move the mouse pointer around the screen you will notice it changes shape (refer
above for a description of the shapes). To draw your first line, move the Mouse pointer onto 
the outline window, it will change to the shape of a pen.

Position the pen a few inches from the Title Box, then click and release the left mouse 
button. A line will be drawn from the pen's position to the title box, and the word 'text' will 
appear on the line.

Type the word Contact. This will replace text on the newly formed line (see Figure 5).

Figure 5

Dragging a line around it's parent
Position the mouse cursor at the tail of the Contact line (The tail is the end furthest away 
from the title box). The mouse cursor will change to a hand symbol. Click the left mouse 
button and drag the line to a new position on the outline and then release the left mouse 
button.



This method is also used to lengthen and shorten lines. If the dragged line has any child 
lines attached to it, then the children will be also be dragged.

Adding further theme lines
To add any further lines, follow the routine used in 'The First Line' section of this tutorial. In 
this example, there are several other themes (see Figure 7). Try running through 'The First 
Line' section several times adding the appropriate themes of Production, Training, Sales and 
Appointment.

NB. To ensure that the line is drawn from the title box, you can position the pen close to the 
Title Box, click the left mouse button and drag the line to a suitable length. Clicking and 
dragging is very useful for larger outlines.

Figure 7

Adding connecting lines
Figure 7 shows the main themes of the outline. Continuing with the Contact theme, now let's
add some detail to it.



The process is the same as adding a line to the title box, except we create a line that joins to
an existing line. To add a new line associated with the word Contact, position the pen close 
to the tail of the Contact line (but not so close that it changes into a hand symbol), then click
and release the left mouse button. A line will be created. Type marketing, and it will appear 
on the new line.

The VisualOutliner automatically draws the line to the closest point of contact, be it the Title 
Box or an existing line. Figure 8 shows an example, which you may like to follow.

Figure 8

Removing unwanted lines
At some stage you may re-organise your outline and this may involve removing some lines 
you no longer require. Removal of these lines is straightforward. In our example let's remove
the line titled samantha.

Position the pen at the tail of the samantha line, the pen symbol will change to a hand. Click 
the left mouse button and drag the line to its parent (this is the figures line). The hand 
symbol will change to an eraser symbol. Release the left mouse button and the line will be 
removed.



If samantha had a note or picture attached to it, then it would have been removed 
automatically.

Inserting a line
To insert a line, select the Insert tool from the toolbar. Position the pen over the tail of the 
Contact line, it will change to a hand symbol. Click the left mouse button and drag the 
mouse until there is sufficient space for the word phone, then release the left mouse button.

A line will be inserted between the Contact line and the two child lines previously attached 
to it. Type phone as the line text (see Figure 10).

NB. New Lines cannot be inserted between the Title Box and the theme lines connected 
to it. Lines may only be inserted between other lines.

Figure 10

Moving a line to a new parent



First, add the letter line as a child to the Contact line.

Select the Move tool from the toolbar. Position the cursor at the tail of the magazine line, 
the cursor will change to a hand. Click and Drag using the left mouse button to pick up and 
move the line to the letter line. When the head of the moved line is positioned over the tail 
of the letter line release the mouse button - the moved line will attach itself to the letter line.
Now move the line around the new parent to the position of your choice. Click & release the 
left mouse button once again to complete the move.

If the line moved has any children of its own, these children will also be moved. This function
permits moving hierarchies of lines from one parent to another.

Editing line text
Click on the MegaCorp line text so that it has the current focus (the text will change to 
white). To edit the text, press the F2 edit function key, MegaCorp will be highlighted in the 
text edit box. Press the END key on your keyboard - this will un-highlight the text and put 
the caret at the end of the word, then type a space followed by UK.The text in the outline will
be updated to MegaCorp UK.

If the text is too long to fit on the line, then drag the line to a longer length.

Formatting the outline
The 'look' of the outline can be changed quite considerably - you can change text attributes 
(bold, italic, strikeout, alignment, font, color, size), line attributes (width, color) and outline 
background color.

If you use any of the Format menu commands then as well as changing any selected 
portion of an outline, you will also be changing the defaults which will be in effect for all 
subsequent editing. Using the toolbar, however, changes the selected portion of the outline, 
but does not change the defaults.

In our example, let's first make the theme lines slightly thicker than the others so that they 
stand out more clearly.

Select the Block select tool from the toolbar. When you move the mouse over the outline 
the cursor will change to a crosshair symbol. Move the crosshair so that it lies over the 
Appointment theme. Click the left mouse button and drag the cursor over to the Production 
theme (notice a dotted rectangle follows your path). Release the left mouse button and the 
contents of the dotted rectangle will be highlighted.

Any editing tools used from the toolbar or Format menu will now apply to all the lines 
touched by the highlighted    block.

If you make a mistake, or have highlighted an incorrect portion of the outline, simply click 
the Block select tool again and the highlighted rectangle will disappear.

Now that you have selected all the theme lines, click on the 3-point line width tool on the 
Toolbar (there are 4 possible line widths, 1, 2, 3, or 4 point). All the theme lines will now be 
drawn with the thicker width.

Our busy manager has now completed all the phone calls, so let's cross out all calls as    



'done'. Use the Block select tool to select the marketing and accountant lines. Now click on
the 'done' tool (Strikeout), both lines will have a line drawn through them.

Experiment with the editing tools on the toolbar (these are to the right of the text edit box). 
Change the text justification, bold/ italic attributes of various lines.

Change the default font, text size & color using the Format Font menu command, then 
draw some new lines.

Notes
The Outline Title Box and each line can have an associated Note. Notes for all Outlines can 
contain up to ten pages of information in total (32,000 characters). Notes conform to 
Windows standards for opening, closing, minimizing, maximizing, scrolling and sizing.

Opening Notes
The purpose of the Note facility is to provide additional information about the line it is 
associated with. In our example we will add a note to the magazine line.

Position the cursor over the magazine line. The cursor will change to a caret shape. Double-
click the left mouse button, and a note window will appear. The title of the note will be 'Note'
followed by whatever was on the line, in our case it is Note magazine.

Working with Notes
Type some details regarding the magazine. You may open multiple notes for each outline, 
though only one per line (and one for the title box, if required). Notes are saved 
automatically as part of an outline.

The Wordwrap option organises the text to fit into the Note window size. Activating this 
option removes the scroll across facility. Wordwrap is an option on the note's Edit menu.

If the magazine information was held elsewhere in an ASCII text file, you could import the 
text file into the note by using the File Import Text command. Any prior contents of the 
note would be overwritten. The text file must be in ASCII format - as used, for example,    in 
the Windows Notepad accessory.

If you want to use the note information in another application, you can export the note text 
by using the File Export text command.

Pictures
The Outline Title box and each line can have an associated Picture (bitmap). The Bitmaps 
should be in .BMP format as used in the Windows Paintbrush accessory.

Opening Pictures

You should first prepare a picture by using an application that can produce bitmaps in .BMP 
format. In our example, we have used Microdoft Excel to produce a bitmap of a graph 
presenting sales figures. The VisualOutliner cannot create bitmap files.



Click on the figures line, and select View Picture from the menu. A blank picture window 
will be displayed. Use File Open Picture to view the bitmap file which you have prepared.

Figure 19a

Printing your work
We will now print our outline. Click on the outline's title bar to make sure it's active.

Select the File Printer Setup command, choose Landscape orientation if available, then 
click on OK.

Select the Print tool from the toolbar, the print options dialog is displayed (see Figure 20).

Figure 20



.

There are three Print Options available, these are :

Print an Outline

Print all Notes.

Print all Pictures.

The default print option is to print    the outline only. Accept the default and click on OK.

Figure 21

When the Outline, Notes and/or Pictures are printing, the Print Progress Box is displayed on 
the screen, with the option to cancel the print, if required. The Print Progress Box also 
contains the Filename of the outline being sent to print and the name of the printer it will be 
printed on (see Figure 21 for an example, the details will depend on your printer and the file 
being printed).

NB: If you wanted to print a single note or picture, then you must make the note or picture 
active before selecting the File Print command (do not use the Print tool as this is for 
printing outlines, and/or all notes or pictures).

Multiple outlines
In our example, TODAY.MAP outline, we might want to start a new outline representing the 
MBA line (our manager is taking a part-time evening management class).

Select the New outline tool from the toolbar, a new outline window will appear, titled 
Outline2. Put in the details for this evening's MBA course. To tidy up the workspace use the 
Window Tile menu command. If any note windows are open, minimise them before doing 
this, unless you want the notes to be tiled also.

Previously created outlines can be opened by selecting the Open tool from the toolbar - the 
Open File dialog will appear. Type the required outline's filename and click on OK.



When re-sizing, or tiling outlines, the title box may disappear from view, to stop this 
happening, select the Options Auto Center menu command - this will center the outline 
within it's window whenever it is re-sized.




